
    


    
    Top
   
    







  
    
      
        
          
            
          
        
        
          
          
            PDFelement: PDF Editor, Scanner

            Edit, Convert, Annotate PDF

            Edit, Annotate PDF

          

        

      

      OPEN
      OPEN
    

  




  
    
      
        
          wondershare
        

        
          
            
          
          
            
          
        
        
          	
  
    Video Creativity
    
      
    
  
  
    
      
        Video Creativity Products

        
          
          
            Filmora
            Complete video editing tool.

          

        
        
          
          
            DemoCreator
            Efficient tutorial video maker.

          

        
        
          
          
            UniConverter
            High-speed media conversion.

          

        
        
          
          
            Virbo
            Powerful AI video generator.

          

        
        
          
          
            Presentory
            AI video presentation maker.

          

        
        View all products
      

      
        Explore

        	Overview
	Video
	Photo
	Creative Center


      

    

  


	
  
    Diagram & Graphics
    
      
    
  
  
    
      
        Diagram & Graphics Products

        
          
          
            EdrawMax
            Simple diagramming.

          

        
        
          
          
            EdrawMind
            Collaborative mind mapping.

          

        
        
          
          
            EdrawProj
            A professional Gantt chart tool.

          

        
        
          
          
            Mockitt
            Design, prototype & collaborate online.

          

        
        View all products
      

    

  


	
  
    PDF Solutions
    
      
    
  
  
    
      
        PDF Solutions Products

        
          
          
            PDFelement
            PDF creation and editing.

          

        
        
          
          
            Document Cloud
            Cloud-based document management.

          

        
        
          
          
            PDF Reader
            Simple and free PDF reading.

          

        
        
          
          
            HiPDF
            Free All-In-One Online PDF Tool.

          

        
        View all products
      

    

  


	
  
    Data Management
    
      
    
  
  
    
      
        Data Management Products

        
          
          
            Recoverit
            Lost file recovery.

          

        
        
          
          
            Repairit
            Repair broken videos, photos, etc.

          

        
        
          
          
            Dr.Fone
            Mobile device management.

          

        
        
          
          
            MobileTrans
            Phone to phone transfer.

          

        
        
          
          
            FamiSafe
            Parental control app.

          

        
        View all products
      

    

  


	Explore AI
	Business
	Shop
	Support
	
              Sign in
            
	
              
              
                
                Account Center
                Sign out
              

            


        

      

    

  
  
    
      
        
          
            
            PDFelement
          
        

        
          
            
          
          
            
          
        
        
          	
              
                Products
                
                  
                    
                  
                

              
              
                
                  
                    
                      
                        
                          
                            Desktop

                            
                            	
                                
                                  
                                    
                                    
                                    
                                    
                                  
                                  PDFelement for Windows
                                
                              
	
                                
                                  
                                    
                                  
                                  PDFelement for Mac
                                
                              
	
                                
                                  
                                    
                                  
                                  PDF Reader for Windows
                                
                              


                          

                        

                        

                        
                          
                            Mobile App

                            
                            	
                                
                                  
                                    
                                  
                                  PDFelement for iPhone/iPad
                                
                              
	
                                
                                  
                                    
                                  
                                  PDFelement for Android
                                
                              
	
                                
                                  
                                    
                                  
                                  InstaScan - PDF Scanner for iPhone
                                
                              


                          

                        

                        

                        
                          
                            Cloud & SDK

                            
                            	
                                
                                  
                                    
                                  
                                  Document Cloud
                                
                              
	
                                
                                  
                                    
                                    
                                  
                                  PDFelement Pro DC
                                
                              
	
                                
                                  
                                    
                                    
                                  
                                  PDFelement SDK
                                
                              


                          

                        

                        

                        
                          
                            
                              What's New
                            

                            
                            	
                                
                                  
                                
                              


                          

                        

                      

                    

                  

                

              

            
	
              
                Solutions
                
                  
                    
                  
                

              
              
                
                  
                    
                      
                        
                          
                            Educational Users

                            
                            	
                                
                                  
                                    
                                    
                                    
                                    
                                    
                                    
                                    
                                  
                                  Read PDF
                                
                              
	
                                
                                  
                                    
                                    
                                    
                                  
                                  Annotate PDF
                                
                              
	
                                
                                  
                                    
                                    
                                    
                                    
                                  
                                  Create PDF
                                
                              
	
                                
                                  
                                    
                                    
                                    
                                    
                                  
                                  Combine PDF
                                
                              


                          

                        

                        

                        
                          
                            Personal Users

                            
                            	
                                
                                  
                                    
                                    
                                    
                                  
                                  Convert PDF
                                
                              
	
                                
                                  
                                    
                                    
                                    
                                  
                                  Edit PDF
                                
                              
	
                                
                                  
                                    
                                    
                                    
                                    
                                    
                                  
                                  Compress PDF
                                
                              
	
                                
                                  
                                    
                                    
                                    
                                    
                                    
                                    
                                    
                                    
                                    
                                    
                                  
                                  Organize PDF
                                
                              


                          

                        

                        

                        
                          
                            Professional Users

                            
                            
                              	
                                  
                                    
                                      
                                      
                                      
                                      
                                      
                                    
                                    PDF Form
                                  
                                
	
                                  
                                    
                                      
                                      
                                    
                                    Sign PDF
                                  
                                
	
                                  
                                    
                                      
                                      
                                    
                                    Protect PDF
                                  
                                
	
                                  
                                    
                                      
                                      
                                      
                                      
                                      
                                    
                                    Batch PDF
                                  
                                


                              	
                                  
                                    
                                      
                                      
                                      
                                      
                                      
                                    
                                    PDF OCR
                                  
                                
	
                                  
                                    
                                      
                                      
                                      
                                      
                                    
                                    Extract PDF Data
                                  
                                
	
                                  
                                    
                                      
                                    
                                    AI-Powered PDF Tool
                                  
                                
	
                                  
                                    
                                      
                                      
                                      
                                    
                                    eSign PDFs Legally
                                  
                                


                            

                          

                        

                        
                          
                            
                              Industries
                            

                            
                            
                              	
                                  Education
                                
	
                                  IT Service
                                
	
                                  Legal
                                
	
                                  Healthcare
                                


                              	
                                  Financial
                                
	
                                  Government
                                
	
                                  Publishing
                                
	
                                  Freelancer
                                


                            

                          

                        

                      

                      
                        All PDF Features
                      

                    

                  

                

              

            
	
              
                Resources & Help
                
                  
                    
                  
                

              
              
                
                  
                    
                      
                        
                          
                            Hot Topics

                            
                            	
                                Top List
                              
	
                                Mac Software
                              
	
                                PDF Apps
                              
	
                                OCR PDF Tips
                              
	
                                Sign PDF Tips
                              
	
                                Edit PDF like Word
                              
	
                                PDF Converter Tips
                              
	
                                PDF Compressor Tips
                              


                            Find More Topics
                          

                        

                        

                        
                          
                            
                              
                                Why PDFelement

                                
                                	
                                    Customer Stories
                                  
	
                                    PDF Software Comparison
                                  


                              

                            

                            
                              
                                Better Use

                                
                                	
                                    Tech Specs
                                  
	
                                    Contact Support
                                  


                              

                            

                            
                              
                                User Guide

                                
                                	
                                    PDFelement for Windows
                                  
	
                                    PDFelement for Mac
                                  
	
                                    PDFelement for iOS
                                  
	
                                    PDFelement for Android
                                  


                              

                            

                            
                              
                                 

                                
                                	
                                    PDF Reader
                                  
	
                                    Document Cloud
                                  
	
                                    InstaScan for iPhone
                                  


                              

                            

                          

                        

                        

                        
                          
                            Explore More

                            
                            	
                                Reviews
                                See what our users say.

                              
	
                                Free PDF Templates
                                Edit, print, and customize free templates.

                              
	
                                PDF Knowledge
                                PDF-related information you need.

                              
	
                                Download Center
                                Download the most powerful and simple PDF tools.

                              


                          

                        

                      

                    

                  

                

              

            
	
              Upgrade
            
	
              Business
            
	
              Download
              Download
              Pricing
              Pricing
            
	
              
                
                  
                    
                    
                  
                
              
            


        

      

    

  


 




          
          
            
              
                
                  Edit PDF Solutions


  	
              
                  Editing Tips

              

              
                  	Free PDF Editor
	Free PDF Writer
	How to Edit File in PDF
	Open Source PDF Editor
	Spell Check PDF
	Copy and Paste from PDF
	Move and Align Objects
	Can't Edit PDF
	PDF Metadata Viewer
	Edit Metadata
	PDF Graphic Editors
	Flatten PDF
	 Online PDF Editor
	Flatten PDF Online
	Edit PDF in Chrome 
	Ubuntu PDF Editor
	Edit PDF on Linux
	Snapshot PDF


              

          
	
            
                PDF Watermark

            

            
                	PDF Watermark Remover
	Remove Watermark from PDF
	Add Logo to PDF
	Add Watermark in PDF
	Free Remove Watermark from PDF
	Online Remove PDF Watermark
	Watermark PDF Online


            

        
	
          
              PDF Background

          

          
              	Remove Background
	 Create PDF with Transparent Background
	Change Background Color
	Color PDF
	Add Background to PDF


          

      
	
        
            PDF Image

        

        
            	Add Image to PDF
	Add a GIF to PDF
	Flip a PDF Image
	Add PNG to PDF
	Remove PDF Image
	Edit PDF Image
	Paste Image into PDF
	Mirror Image in PDF
	Add Image to PDF Online
	Add Picture to PDF
	Crop Image in PDF
	Manage PDF Layers
	Insert Image to PDF
	Insert Picture into PDF
	Add Photo to PDF
	PDF Image Editor
	Insert Photo into PDF


        

    
	
        
            PDF Text

        

        
            	Edit PDF Text
	Insert Text into PDF
	Increase Font Size
	Edit PDF Font
	Change Font Color
	Copy Text from PDF
	Edit Font Size
	Select Text in PDF
	Delete Text from PDF
	Change Font in PDF
	Edit PDF Text Online
	Change Text Color
	Change Font Size


        

    
	
        
            PDF Link

        

        
            	Add Link to PDF 
	Hyperlinks Not Work in PDF
	Create URL for PDF
	PDF Link to Page
	Embed Video in PDF
	Edit Link in PDF
	Remove Link from PDF
	Create Link for PDF 
	Add Audio to PDF
	Add Video in PDF


        

    
	
        
            PDF Page Numbers

        

        
            	Add Page Numbers to PDF
	Add Header and Footer to PDF
	Remove Footer from PDF
	Add Bates Numbering
	Change Page Numbers in PDF
	Insert Page Number in PDF
	Start Page Number on Page 3
	 Add Page Numbers Online


        

    
	
        
            Translate PDF

        

        
            	Translate PDF
	Translate Scanned Document
	Google Translate PDF
	English to Hindi
	English to French
	French to English
	English to Spanish
	Spanish to English
	Japanese to English
	German to English


        

    


  Try It Free    Try It Free  Try It Free


                

              

              
                  
            

          
          


    
		
		  	  	    
      
    
		
      
        
          How to Copy Text from PDF

        

      

      
        

          
            
              
            

            
              
                
                  
                    Margarete Cotty

                  

                

                
                  
                    2024-03-04 14:02:30 • Filed to:
                    PDF Text
                    • Proven solutions
                  

                

              

            

          

          PDF is the easiest and most secure way of sending and receiving important content. So can we copy text from PDF? From this article, you can learn why some PDF files can't be copied and how to copy text from PDF offline or online.



  Try It Free
  Try It Free
  BUY NOW
  BUY NOW



  
    
      
    
    
      
    
  

  Try It Free





	Can't copy text from PDF? Why and How to Solve it
	How to Copy Text from PDF with 3 Solutions
	How to Copy Text from PDF Online
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	FAQs about Copying Text from PDF




Can't Copy Text from PDF?

If your PDF file is not selectable and can't be copied, the PDF file is either protected from copying or created by scanning.

	Copy text from secure PDF: There is a password restriction on the PDF file, which protect the content in the PDF from being copied or printed. To copy text from a secured PDF, you need to remove the password restriction first.
	Copy text from PDF image: The PDF document is created from an image or from a scanner so that you can't copy text from it. To make the scanned PDF copyable, you can use an OCR tool to scan and detect text from the PDF file.


Read on and learn how to copy text from PDF offline and online, including copying text from scanned or secured PDF.

Tip: How to check if content copying is allowed on the PDF?

If you have a PDF editor such as PDFelement, Adobe Acrobat on your computer, you can easily check if content copying is allowed on the PDF file. To check a PDF’s restrictions, open the PDF file in PDFelement or another PDF software. On PDFelement’s menu bar, select File > Properties. On the Properties window, click the "Security" tab and check if the "Content Copying" is allowed. If it says "Not Allowed," you can't copy text the PDF file.



How to Copy Text from PDF with 3 Solutions

With Wondershare PDFelement - PDF Editor, you can copy words from PDF easily. If the PDF document is a normal copyable PDF file, you can open it in PDFelement, select the text to copy and paste directly.

To conpy text from a scanned PDF, click its OCR button to perform OCR. Then the newly created file will be editable for you to copy text.

To copy text from secured PDF, PDFelement still can help you copy text from PDF with some extra steps.

Before you continue, make sure you've downloaded the latest version of PDFelement. Once the download is completed, follow the simple installation process, which will take only a few seconds.
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How to Copy Text from Copyable PDF

Step 1. Load PDF

Now, Run the recently installed PDFelement and open the PDF document that you want to copy. On the Home tab, click on the "Open File" button. Now, select the PDF file from which you want to copy text and click on the "Open" button again.



Step 2. Copy Words from PDF

Once the document is opened, click the "Select Mode" button on the bottom to make the text selectable. Then use your mouse click to select the text as you want or press CTRL + A to select all text.

Then you can copy text in 2 ways.

	Right-click on the text and select "Copy Text"
	Press "Ctrl + C" after selecting the text




Step 3. Edit Your PDF(Optional)

Using the editing mode can also help you change text in PDF. Click the "Edit" button to enable the editing mode, and you can then edit text in PDF.
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How to Copy Text from PDF to Word

If you want to copy all text from a PDF file, there is another way for you to copy text from PDF to Word, that is converting PDF to Text or Word directly.
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Step 1. Open PDF

After opening PDFelement, click the "Open File..." button to select your PDF document to be opened.



Step 2. Copy Text from PDF to Word

Click the "Convert" > "To Word" button to start the conversion. This is how to copy text from pdf to Word. And if you want to copy text from a PDF to a TXT file, you can click the "To Text" button to do so directly.





How to Copy Text from PDF Image

After opening a PDF image in PDFelement, the program will detect that this is a scanned PDF and show you the "Perform OCR" button. Or you can go to "Tools" > "OCR" to make the PDF copyable. Click "Perform OCR" and click "Apply" on the pop-up window. PDFelement will then OCR the PDF. When the process is complete, you can now select and copy text from the PDF. Learn more about How to Copy Text from Scanned PDF.





How to Copy Text from Secured PDF

After opening a secured PDF in PDFelement, the program can also detect the file is protected and ask you to enter the password of the PDF. Once you have entered the password, you can copy text from the PDF document now. Learn How to Remove Password Protection from PDF.
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PDFelement lets you add new text, delete text, or modify text within your document. You can also replace the images in the PDF file, resize them, or adjust their orientation. One of the best features is the built-in OCR tool, which will let you extract text from scanned PDF files.

In addition, PDFelement lets you can create PDF from different images, blank pages, slides, or forms. Similarly, you can convert any PDF file into Word, PPT, Excel sheets, or even webpages. Once you have created a PDF file, it can also be protected using a password to prevent unauthorized access and editing.





How to Copy Text from PDF Online

One of the easiest ways to copy text from a PDF document is to use a PDF conversion tool. There are several online PDF to text conversion tools such as HiPDF, Adobe Acrobat, SmallPDF, and more. Here we will show you how to use HiPDF to convert PDF to Word so that you can easily copy text from the PDF.

Step 1. Open PDF to Text on HiPDF. Simply upload your PDF file to the website.

Step 2. If this is a scanned PDF, you can select OCR to convert it to an editable PDF. Then click "Convert" to convert the PDF to a Word document.

Step 3. Once the conversion is complete, download the document and you can easily copy the text you need.







How to Copy Text from PDF on Mac

If you are using a Mac computer, you can open the PDF file in Preview and copy the text.

To copy text from a PDF in Preview on your Mac, open the desired PDF. Select it with the Text Selection tool, and then choose the "Copy" option under the "Edit" menu. Now you can paste the text into a Word processing program or anywhere you need.





FAQs about Copying Text from PDF



1. How to copy text from a PDF using Adobe Acrobat?



To copy text from a PDF using Adobe Acrobat, follow these steps:

Open the PDF file in Adobe Acrobat. Select the "Text Select" tool from the toolbar, which looks like a cursor.

Click and drag the cursor over the desired text to highlight it. Right-click on the highlighted text and choose "Copy" from the context menu.

Alternatively, you can use the keyboard shortcut Ctrl+C to copy the selected text from PDF to your clipboard.








2. How to enable copy and paste on a PDF?



Normally, you should start copying text from PDF with shortcuts like Ctrl+C and Ctrl+V(⌘ + C and ⌘ + V on Mac). If you find it impossible to copy and paste on a PDF, the PDF file is probably created with usage-based restrictions, which you can remove with a PDF password remover.








3. When I copy text from a PDF, it is gibberish?



If you get gibberish text after copying text from a PDF, the problem likely stems from the font. The fonts used in the PDF lack Unicode tables or don't utilize standard encoding. Also, maybe the fonts of the PDF are supported on your system. Consequently, you might end up with gibberish text when copying and pasting text from the PDF.

To fix the problem, you should use PDFelement to convert the PDF file to images(JPG/PNG), then open the PDF images in PDFelement, and perform OCR to recognize the text in a supported font. Now you can copy text from the PDF without problem.








4. How to copy hindi text from PDF?



To copy hindi text from a PDF, you can try PDFelement, which can read, edit hindi text in PDF.








5. How to copy text from PDF free from browers? 



PDF files can be opened on browsers such as Chrome, Firefox, or Edge. After opening the PDF file in a brower, you can select and copy text from the PDF if the PDF is not password protected nor a image-based PDF.









Conclusion

There are different methods to copy texts from PDFs. Choose the one that suits your needs best. PDFelement is an efficient and easy-to-use program for copying text from . It works well with scanned or even secured PDFs and loads quickly. Even newbie users can work on it comfortably.
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